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Abstract 

The manufacture of prototypes using metal additive manufacturing (AM) has been used for many 

years, however, there has been little research on how to heat treat AM aluminum parts to match the 

properties of parts manufactured using high pressure die casting (HPDC). Prototypes made using 

sand casting can only reach 70% of the strength of production HPDC parts, which is not ideal for 

early testing. As printed, the strength of AM aluminum alloys manufactured with Powder Bed Fusion 

– Laser Beam (PBF-LB) is much higher than HPDC aluminum alloy. Hence, AM parts can be heat 

treated to reduce their strength until it matches that of HPDC parts. This research investigated how 

the heat treatment of AM aluminum alloy AlSi10Mg affects its hardness, yield strength, ductility, 

and microstructure, as well as the mechanisms that cause the changes in properties. In addition, a 

replica of a production HPDC part was manufactured using AM to develop a prototype manufacturing 

process and to compare the results between them. The results showed that heat treating AM parts at 

325ºC for 4 hours produced the closest yield strength to that of HPDC parts. However, the ductility 

was much greater for the AM parts due to differences in alloying elements and microstructure. For 

making an AM demonstrator, the process developed was to manufacture the part with PBF-LB along 

with some tensile bars, heat treat the part on the build plate, machine any critical surfaces, remove 

the support material, and treat the surface with glass blasting to remove any remaining 

particles/powder on the surface. 

 

Keywords: Additive manufacturing, Powder Bed Fusion – Laser Beam (PBF-LB), High pressure die 

casting, Aluminum alloy AlSi10Mg, Heat treatment, Material characterization, Hardness, Tensile 

strength, Microstructure 
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1 Introduction 
High pressure die casting is a casting method that allows for the mass manufacture of nonferrous 

metal parts with complex geometries. The process involves using high pressure to force a liquid metal 

into a tool steel mold, which is able to rapidly cool the part [1]. Die casting produces very little 

material waste (as compared to conventional machining) and has the ability to use recycled alloys 

with higher levels of impurities [2]. 

Powder Bed Fusion – Laser Beam (PBF-LB) is a method for producing metal parts via additive 

manufacturing by selectively melting layers of powder on top of each other until a final part is 

produced. Unlike other methods that simply bind the powder together to later be sintered into a solid 

mass, PBF-LB directly produces solid parts (although post AM heat treatment may be needed to 

reduce residual stresses and provide the final microstructure).  

Die casting requires an expensive mold that is complex to manufacture, so designing a part and 

iterating it with prototypes can become a very expensive and time-consuming process. While sand 

casting can produce prototypes with the correct geometry, the process is still relatively time 

consuming, and the parts produced have worse strength properties compared to parts produced by 

HPDC. Producing single prototype parts using metal additive manufacturing can greatly reduce the 

time and cost by not requiring a mold to be made for each iteration and giving the option to 

manufacture parts in-house. Finding a process that meets these goals will allow designers to spend 

less time and produce less waste during the prototyping phase while also allowing for the freedom to 

test the viability of more complex and optimized designs. 

The heat treatment of aluminum made by PBF-LB is well documented in research, however the 

majority of research focuses on either precipitation hardening treatments (like T5 or T6) that improve 

ductility while maintaining a high yield strength or stress-relief treatments that reduce the residual 

stresses caused by rapid cooling during laser melting. Less research has been done on reducing the 

properties through spheroidizing heat treatments and almost none has been done to compare AM parts 

to those made with HPDC.  

The spheroidization process was characterized using scanning electron microscopy and differential 

scanning calorimetry by [3] which indicated that the spheroidization process begins around 290ºC, 

with a peak occurring around 340ºC. 
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2 Materials and Methods 

2.1 Alloy choice 

The aluminum HPDC alloy investigated for this project is alloy AlSi12(Fe). This alloy includes 

10.5% to 13.5% silicon to improve castability by increasing fluidity and decreasing shrinkage [4]. 

Compared to the previous HPDC alloy used for this application (AlSi9Cu), this alloy has improved 

corrosion resistance due to lower amounts of iron and copper. However, the remaining iron is 

considered a contaminant that reduces the ductility and tensile strength of the alloy by forming 

platelet-shaped intermetallics (such as β-Al5FeSi) that act as stress concentration sites [5], [6]. This 

is usually because the alloy contains some amount of recycled material, which tends to accumulate 

alloying and impurity elements, as these are difficult to remove in the recycling process [7], [8]. By 

using recycled aluminum, the carbon footprint of manufacture can be greatly reduced, as remelting 

of secondary aluminum uses only 5-10% of the energy of primary aluminum [2], while also being 

cheaper [7].  

In additive manufacturing, the most used and studied aluminum alloy is AlSi10Mg, with AlSi12, 

A356 (AlSi7Mg0.3), and A357 (AlSi7Mg0.7) also being relatively common [9]. Silicon is added to 

these alloys for the same reason it is in casting alloys as it decreases shrinkage, which is very 

important for parts made by PBF-LB, where the melting and solidifying of individual layers in the 

parts makes them susceptible to residual stresses [9]. The magnesium is added to form Mg2Si 

precipitates that allow the alloy to be precipitation hardened [10]. As the die cast parts considered do 

not use precipitation hardening, the AM parts were not hardened either.  

AlSi10Mg was chosen as the AM alloy because of its similarity to the existing HPDC alloy being 

used (AlSi12(Fe)) and due to its wide availability as an AM aluminum alloy. The primary difference 

between the two is that AlSi10Mg is more ductile from its lower iron content and can be made 

stronger through precipitation hardening [10]. However, ductility is not relevant to the primary 

testing, prototypes are primarily used for strength testing, and the strength of the AM prototypes in 

this study will be tuned with a simpler annealing heat treatment. Ductility mainly becomes important 

during crash testing, which is generally done with final HPDC parts. 

2.2 Material properties 

The most relevant material parameters for part prototyping are strength and friction/surface roughness 

properties. Having the correct yield and tensile stresses allows for the part to be fully loaded during 

testing without worrying that the material is unrepresentative. Given that some joints in the HPDC 

parts are unmachined, having a similar surface roughness ensures that the friction stresses on the 

joints will be accurate. Ductility is an important property in production parts, as ductility affects the 

energy absorbed by a part during failure, such as during a crash. However, crash testing is only done 

with final HPDC parts, and since this research primarily focuses on early prototypes, ductility was 

measured but not considered as a material parameter to optimize for. 

2.3 Sample preparation 

All the parts and samples manufactured with AM in this research used PBF-LB/M to do so. This AM 

process works by using a laser to melt layers of metal powder, eventually building up a final part. 

The process starts with a recoater spreading a thin layer of metal powder across a build plate made of 

the same or a similar material, with any remaining powder ending up in the collector. The powder 

particles must have good spheroidicity and a relatively narrow size distribution to ensure good 

flowability across the build platform, or else the recoater may leave gaps in the layer, resulting in 

high porosity. After the powder layer is spread out, a high power laser is scanned across the surface 
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to melt the powder into a solid metal. Heat is conducted away from the melt pool to rapidly solidify 

the metal. After the laser has scanned across the surface, the build platform moves down a defined 

step (20 to 100 μm, depending on the material and process), and the recoater spreads another layer of 

metal powder to be melted to the previous layers by the laser. The melt pool produced by the laser 

generally extends to both the current powder layer and a few previous layers to ensure the layers are 

well bonded. The direction the laser scans generally changes with each layer as well to reduce 

anisotropy. For parts with overhangs, supports are generally needed to improve the print quality, 

prevent warping from the rapid cooling, and conduct heat away from the melt pool. A simplified 

diagram of the PBF-LB process is shown in Figure 2.1.  

 

Figure 2.1: Diagram of the PBF-LB/M manufacturing process. 

To manufacture the AM test samples, AlSi10Mg powder was used in an SLM Solutions SLM 125 

and SLM 280 with 30µm and 60µm layer thickness, respectively. For tensile specimens, four 85 mm 

x 85 mm x 5 mm thick walls were printed vertically to allow for tensile samples to be cut out and 

machined in both a vertical and horizontal orientation (see Figure 2.2). For surface treatment analysis, 

a set of 10 mm x 10 mm x 10 mm cubes were printed to have different surface treatments tested for 

surface roughness. For metallography and hardness specimens, scrap 3D printed parts from previous 

projects were cut into approximately 10 mm x 10 mm x 5 mm slices to allow cross sections to be cut 

in multiple orientations and for different methods of heat treating to be tested to observe differences 

in hardness and microstructure.  
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Figure 2.2: Print orientation for the horizontal test bars (left) and vertical test bars (right). 

To test the process parameters on an actual part and any post-processing parameters, two example 

prototypes of existing HPDC brackets were made from AlSi10Mg using PBF-LB. Examples of the 

as-printed prototype brackets are shown in Figure 2.3. 

 

Figure 2.3: Printed powertrain suspension bracket on the build plate. 

For testing samples of AlSi12(Fe) manufactured by HPDC, tensile test pieces were cut out from a rib 

of a preexisting HPDC part with the same dimensions as the AM samples. The part used and section 

that the samples were cut out from are shown in Figure 2.4. 



 

 

 

5 

 

 

Figure 2.4: HPDC part used for tensile samples. Original part on left, part with samples cut out on right. 

2.4 Heat treatment 

A Carbolite STF15/75/450 ceramic tube furnace using atmospheric air (Figure 2.5) and a dilatometer 

Netzsch DIL 402C with an argon atmosphere were used to heat treat the samples. For the ceramic 

tube furnace, a ramp rate of 10°C/min was used during the ramp phase and the majority of the samples 

were cooled by air cooling, with some specific samples cooled with either water quenching or furnace 

cooling at 1ºC/min. With the dilatometer, a ramp rate of 5ºC/min was used during the ramp phase and 

the samples were cooled by furnace cooling. The dilatometer was used to have very precise 

temperature control. The goal was to spheroidize the microstructure of the studied aluminum alloy to 

decrease the strength from the silicon cellular microstructure formed by rapid cooling of the metal 

during printing. Hence, annealing temperatures in the range of about 250-550 °C were tested. In 

addition, heat treatment holding times in the range of 0.5-4 hours were also studied. 

 

Figure 2.5: Ceramic tube furnace used for heat treating samples. 

2.5 Hardness testing 

In order to cover a larger range of heat treatment times and temperatures, heat treated samples were 

first hardness tested using a Struers DuraScan microhardness tester (Figure 2.6), using a Vickers 

indenter with a load of 500g (HV0.5). This was converted to yield strength and tensile strength using 
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an approximate conversion developed by [11]. By using those results it was possible to limit the range 

of samples that needed to be tested using tensile testing and to get close to the correct treatment 

temperature faster. 

 

Figure 2.6: Struers DuraScan microhardness tester used to measure hardness. 

2.6 Tensile testing 

Standard tensile tests (according to ISO 6892-1:2019) were performed in an Instron 5500R universal 

testing machine at Chalmers (Figure 2.7) and a Zwick 250 material testing machine at AB Volvo to 

find the yield stress, the ultimate tensile stress, and the elongation at fracture of both the cast and 

printed aluminum samples. Samples of HPDC AlSi12(Fe) were cut from the ribs of a part in 

production at Volvo Cars (see Figure 2.4), and as such were limited in length by the dimensions of 

the rib to 80 mm long. To obtain samples of AM AlSi10Mg, 85 mm x 5 mm x 85 mm vertical walls 

were printed, which were then machined into tensile bars both parallel and perpendicular to the print 

direction (Figure 2.2). The dimensions of both sets of bars are shown in Figure 2.8. The dimensions 

of these tensile samples were based on the size of a Subsize Specimen in ASTM standard E8/E8M, 

Standard Test Methods for Tension Testing of Metallic Materials, although since it required an 

overall length of 100 mm, the length of the grip section was reduced from 30 to 22.5 mm and the 

length of the reduced section was reduced from 32 to 21.73 mm. 
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Figure 2.7: Tensile test setup. 

 

 

Figure 2.8: Tensile bar dimensions. 

 

2.7 Metallography 

Cross sections of the cast, as-printed, and heat-treated aluminum were cut, mounted in Struers 

PolyFast, polished, and etched with Keller’s reagent in order to observe the microstructure through 

light microscopy and electron microscopy. Samples were polished by first grinding with 220 grit, 500 

grit, and 1000 grit SiC sanding discs using water as a lubricant, then polished using Struers DiaPro 

Largo 9µm on an MD-Largo surface, DiaPro Dac 3µm on an MD-Dac surface, and OP-U NonDry 
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on a MD-Chem surface. To etch the samples, Keller’s reagent was applied to the polished surface 

with a cotton swab and was swabbed in circles for 30 seconds, after which the remaining etchant was 

rinsed off using deionized water. The microstructure was analyzed using ImageJ to look for changes 

in spheroidization and precipitate growth relative to treatment temperature and time.  

Both light optical microscopy and scanning electron microscopy were used to characterize the 

microstructure of the samples. Light optical microscopy was used to measure porosity and study the 

microstructure of the molten pools from the PBF-LB process, while scanning electron microscopy 

was used to study the microstructure and precipitates of the aluminum-silicon alloys. An SEM was 

needed because the size of the precipitates in the studied samples are near the resolution limit of light 

optical microscopes, meaning fine precipitates cannot be resolved. A Zeiss Axioscope 7 (Figure 2.9) 

was used for the light optical microscopy, while a Philips XL30 ESEM (Figure 2.10) was used for 

the scanning electron microscopy. 

 

Figure 2.9: Zeiss Axioscope 7 used for imaging the microstructure and porosity. 

 

 

Figure 2.10: Philips XL30 ESEM Used for imaging the microstructure. 
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2.7.1 Image analysis 

The Fiji distribution of ImageJ was used for all the image analysis required for the project.  

The procedures used for the different types of image analysis are described below: 

Process for finding average particle size: 

• Import image into ImageJ. 

• Lay horizontal line over scale bar, go to Analyze > Set Scale, put known distance as scale bar distance. 

• Drag a rectangle selection over the image area to crop out the image information section, then select 

Image > Crop. 

• Plugins > Segmentation > Trainable Weka Segmentation. 

• Highlight areas of particles and background into two classes, then Train classifier 

o If particles don’t look good, retrain with more highlighted areas. 

• Create result. 

• Convert into Image > Type > 8-Bit. 

• Threshold into Black and White, with white being particles, by checking or unchecking “Dark 

Background”. 

• Use the Adjustable Watershed plugin to separate any particles that are merged together in the binary 

image. 

• Analyze > Analyze Particles, check Clear results and Overlay, make sure minimum size is set to 0. 

• Look in the image for the smallest outlined particle that also corresponds to a particle in the original 

image, measure it by selecting it using the wand tool and using Analyze > Measure. 

• Take a size slightly smaller than that and rerun Analyze Particles with that smaller size as the minimum 

size. 

• Analyze > Distribution for average particle size. 

 

Process for finding porosity in microscopy samples: 

• Import image into ImageJ. 

• Drag a rectangle selection over a portion of the microscopy image with no scratches to minimize noise 

from non-pores, then select Image > Crop. 

• Convert into Image > Type > 8-Bit. 

• Image > Adjust > Threshold, use Intermodes method to automatically choose threshold value. 

• Analyze > Histogram, taking the resulting mean and dividing by 255 will give the portion of pores in 

the image. 

 

Process for finding porosity in CT scans: 

• Export an image slice every 1 mm for the whole scan. 

• Import a representative image into ImageJ. 

• Highlight areas of pores, metal, and background into three classes, then Train Classifier. 

o Retrain with more data if the final classified image doesn’t look good. 

• Save the classifier to use on all the images. 

• Save the image slices into stacks of images that can be classified at once without running out of 

memory. 

o For this project, 9 images could be classified at a time with 32GB of installed memory. 

• Create result. 

• Analyze > Histogram > Include all n images > List 

o Value 0 is the count of all pixels for the first classifier, value 1 is the second classifier, and 

value 2 is the third classifier. 
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• Total average porosity is the sum of all pore pixels divided by the total sum of pore and metal pixels. 

 

2.8 Surface characterization 

To compare the surface roughness of HPDC, as printed, and surface treated parts, surface 

characterization of the roughness was done at RISE with a SensoFar Neox S using a confocal method. 

Two surface treatment methods, glass blasting and Hirtisation®, were compared. These were also 

performed at RISE on two 10 mm x 10 mm x 10 mm printed cubes. 

 

Figure 2.11: SensoFar Neox S Non-contact 3D optical profiler (from [12]). 

2.9 Surface scanning 

To observe the accuracy of the print and how each post-processing step affected the dimensions of 

the bracket prototype, part scanning was performed at Volvo Cars between each post-processing step 

using a HandyScan 700 3D. The resulting files were compared to each other and the base model using 

PolyWorks and MeshLab to analyze and highlight any dimensional differences.  

2.10 CT scanning 

CT Scanning was performed at Volvo Cars on both the finished printed part and the original HPDC 

part with a Comet Yxlon FF35 CT scanner using a voxel size of 62.2 μm. This allowed for the 

measurement and comparison of internal porosities for both parts. 

 

Figure 2.12: Comet Yxlon FF35 CT scanner (From [13]). 
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2.11 Prototype test part post-processing 

2.11.1 Heat treatment 

To heat treat the final prototype part, a large nitriding furnace at Härdservice AB was used. A large 

furnace was used to ensure the entire build plate could be heat treated with supports still attached and 

to provide accurate temperature control.  

 

Figure 2.13: Nitriding furnace at Härdservice used for heat treatment of the build plate. 

Heat treatment was chosen as the first post processing step to eliminate residual stresses in the part 

and prevent it from deforming when removed from the build plate. At higher temperatures, this can 

carry a risk of sintering residual powder on some surfaces, but the heat treatment temperature was 

low enough that it was not an issue. 

 

Figure 2.14: Heating and cooling process plot of the heat treatment performed at Härdservice. 
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2.11.2 Machining 

The AM bracket prototype was machined at RISE using a 5-axis milling machine to provide the final 

finish on critical surfaces, remove support material, and remove the parts from the build plate. The 

build plate was first mounted on a large spacer block to provide more space to access the sides (see 

Figure 2.15). The first step in machining was to mill the upper mounting surfaces so they could later 

be used as a reference, then to mill out the material in the central hole, while the bracket was still 

attached to the build plate. The parts were then cut off the build plate, loose support material was 

removed, and the bottom mounting surfaces were machined. 

 

Figure 2.15: Spacer block used for raising the build plate. 

 

 

Figure 2.16: Central hole of powertrain suspension bracket being milled out. 
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Figure 2.17: Powertrain suspension bracket being removed from build plate. 

 

 

Figure 2.18: Powertrain suspension bracket mounted upside down for support removal. 

 

2.11.3 Surface treatment 

Glass blasting was chosen as the method for surface treatment as it more consistently reduced the 

surface roughness of the printed parts and was more readily available than Hirtisation®. 
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Figure 2.19: Powertrain suspension bracket after (left) and before (right) surface treatment with glass blasting. 

2.11.4 Bushing mounting 

To complete the bracket prototype, a rubber bushing needed to be mounted in the central hole so it 

can be mounted in a testing setup, as shown in Figure 2.20. 

 

Figure 2.20: Example test mounting setup for a similar bracket. 

This was done by pressing the bushing out from an existing production bracket manufactured with 

HPDC (Figure 2.21, left), then pressing the bushing into the 3D printed bracket (see Figure 2.22). 
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Figure 2.21: Production HPDC bracket (left) and post-processed 3D printed bracket (right). 

 

 

Figure 2.22: Post-processed 3D printed bracket with rubber bushing mounted. 
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3 Results and Discussion 

3.1 Hardness 

The hardness of the as-printed AlSi10Mg was found to be 129 ± 4 HV while the hardness of the 

HPDC AlSi12(Fe) was found to be 79 ± 3 HV. Next, samples were heat treated between 300ºC and 

500ºC at 50ºC increments for one hour in a Netzsch DIL 402C dilatometer to characterize how the 

hardness changed with temperature (see Figure 3.1). Once this was done, samples were heat treated 

at 250ºC to 550ºC for 0.5 to 4 hours in a Carbolite STF15/75/450 ceramic tube furnace, as these 

temperatures showed the closest hardness and theoretical yield strength to the HPDC aluminum (see 

Figure 3.2).  

 

Figure 3.1: Hardness of AlSi10Mg samples heat treated at temperatures between 300°C and 500°C for 1 hour, 

followed by uncontrolled cooling in the dilatometer. 

 

 

Figure 3.2: Hardness of AlSi10Mg samples heat treated at temperatures between 250ºC and 550ºC for 0.5 to 4 hours, 

followed by uncontrolled cooling in air. 
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Figure 3.3: 3D plot (left) and contour plot (right) of hardness with respect to treatment time and temperature. 

The effect of the ramping portion of the heat treatment cycle was also analyzed by both taking a 

sample out right as it reached the treatment temperature at 400ºC, as well as putting a sample in the 

furnace right as it reached the treatment temperature and comparing that to the sample that was in the 

furnace for the entire cycle. The hardness results are shown in Table 3.1. 

Table 3.1: Hardness of AlSi10Mg samples under different ramp conditions 

Sample Hardness (HV) 

1h 400ºC, 10ºC/min ramp rate 63 ± 1 

1h 400ºC, set in 400ºC furnace 63 ± 1 

10ºC/min ramp rate, taken out once 400ºC reached 82 ± 2 

 

The results in Table 3.1 show that while having the sample in the furnace during the ramping portion 

of the heat treatment cycle will lower the hardness, it does not have a significant effect on the final 

hardness after holding (at least for small samples that are able to heat up quickly). 

The time and temperature curves for hardness show that at a given temperature, the hardness will 

asymptotically reach a minimum value, meaning that continually increasing the treatment time will 

not significantly change the hardness. This is in agreement with the results presented in [14], which 

found that after about 6-8 hours, the hardness will not decrease any further. This shows that the 

microstructure changes that reduce hardness are temperature activated and hence temperature has a 

major effect that can control hardness. From this, it was chosen to control hardness (and thus tensile 

properties) by temperature, while keeping the dwell time consistent, as this gives more flexibility 

during the specification of the heat treatment process. By letting the heat treatment run for a longer 

time at a lower temperature, a small difference in run time will give lower variance than running a 

heat treatment for a shorter time at a higher temperature, even if they should theoretically give the 

same properties. 

Figure 3.1 and Figure 3.2 show some differences in the measured hardnesses of heat treatments 

performed at the same temperature and time, with the hardness values in Figure 3.2 being consistently 

higher than those in Figure 3.1. The most likely reason for this is due to the differences in cooling 

rate, as the samples in Figure 3.1 were allowed to cool slower by keeping them in the dilatometer 

they were heat treated in as it cooled to room temperature. In contrast, the samples in Figure 3.2 were 

taken out of the tube furnace once the treatment time was up and allowed to cool by sitting in the 

open air. Since the samples were only than 10 mm x 10 mm x 5 mm, the samples in Figure 3.2 cooled 
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to room temperature relatively quickly (within ~5 minutes), meaning that it is likely that some amount 

of solid solution strengthening occurred, causing the hardness to increase. 

3.2 Tensile data 

Using the hardness values obtained from the metallography samples, the range of temperatures and 

times that needed to be tested using tensile tests could be minimized. As there is a direct correlation 

between the hardness and tensile properties of a metal [15], previous research on AlSi10Mg could be 

used to approximate the tensile properties for testing. According to [11], the yield strength of 

AlSi10Mg (in MPa) correlates to Vickers hardness using Equation (3.1) with a linear fit and Equation 

(3.2) with a linear fit and the intercept set to zero, both for HV values between 95-125.  

𝜎𝑦 = 2.54 𝐻𝑉 − 49.62 (3. 1) 

𝜎𝑦 = 2.155 𝐻𝑉 (3. 2) 

To know what yield stress to aim for, tensile samples were cut from production AlSi12(Fe) HPDC 

parts and tested, which was compared to literature values to confirm that testing was done correct. 

The yield stress from these tensile samples were measured to be 132 ± 3 MPa. The engineering 

standard of Al alloy 44300 (AlSi12(Fe)) manufactured by HPDC has a minimum specified yield 

strength of 130 MPa [16]. Another research paper comparing the strength of alloys cast with HPDC 

and VADC (Vacuum assisted die casting) found the yield strength of AlSi12(Fe) manufactured with 

HPDC to be 128 MPa [17]. Based on these three sources, the target yield stress for the heat treated 

AlSi10Mg was set to 130 MPa. 

Based on the two yield strength approximations, a range of about 60-66 HV should get close to the 

yield strength of the HPDC Al. The two closest hardness values at 2 hours of holding time were 350ºC 

and 400ºC, so both were tested using tensile bars that had been cut out in a horizontal orientation. 

The orientation was chosen because parts are generally stronger when printed horizontally [18], and 

for this project it is better to know the maximum yield strength rather than the minimum yield strength 

at a given temperature and time. The tensile results are shown in Table 3.2. 

Table 3.2: Tensile data results from the tensile bars. Note, only one sample was tested for each of the 2h 

350ºC and 2h 400ºC conditions, so no confidence intervals can be provided. 

Material Yield Stress 

(MPa) 

Ultimate Tensile Stress 

(MPa) 

Elongation at Failure 

(%) 

HPDC AlSi12(Fe) 132 ± 7 204 ± 32 1.8 ± 1.1 

As-Printed AlSi10Mg (Horizontal) 269 ± 17 428 ± 5 9.5 ± 1.6 

As-Printed AlSi10Mg (Vertical) 262 ± 4 448 ± 3 5.9 ± 1.0 

AlSi10Mg 2h 350ºC (Horizontal) 126 207 29.1 

AlSi10Mg 2h 400ºC (Horizontal) 112 189 31.1 

AlSi10Mg 4h 300ºC (Horizontal) 139.5 ± 1.0 231 ± 6 22.9 ± 0.5 

AlSi10Mg 4h 325ºC (Horizontal) 127.0 ± 0.8 214.3 ± 1.2 27.8 ± 1.2 

AlSi10Mg 4h 325ºC (Vertical) 123.5 ± 1.0 209 ± 14 28.4 ± 0.9 
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Figure 3.4: Yield stress of selected tested materials. 

 

 

Figure 3.5: Ductility of selected tested materials. 

The two tensile bars yielded at 126 and 112 MPa, respectively, both giving tensile values below the 

HPDC yield stress. Comparing to the tested hardness, both of these values are approximately 1.8 

times the Vickers hardness. To get closer to the tested yield stress, the hardness values were 

interpolated between 300ºC and 350ºC, giving a temperature of 327ºC. Based on this, the next test 

was decided to be a heat treatment at 325ºC for 4 hours to ensure greater consistency. In addition, a 

heat treatment at 300ºC for 4 hours was also performed to provide a data point for interpolation if the 

yield strength at 325ºC ended up being too low. Three tensile bars were treated at 325ºC and two 

were treated at 300ºC to give more confidence in the results. 

The results show a yield stress of 127.0 ± 0.8 MPa for the samples treated at 325ºC and 139.5 ± 1.0 

MPa for the samples treated at 300ºC. This gives a 3.8% deviation from the HPDC yield stress, which 

is within the desired limits of 10% deviation, especially given that the confidence interval around the 

yield stress of HPDC AlSi12(Fe) is relatively high at ± 7 MPa. It is desirable for the AM prototype 

yield stress to be slightly below that of the final HPDC parts, as this ensures that any load that would 
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create yielding in the final part would also create yielding in the prototype. In addition, comparing 

the stress-strain curves of selected tensile samples (as in Figure 3.6), the shape of the curves is near 

identical, showing that the plastic response of the heat treated AM processed AlSi10Mg is near 

identical to that of the HPDC AlSi12(Fe), at least until fracture of the HPDC samples, after which the 

AlSi10Mg is able to extend much further, as can be seen in Figure 3.6. 

 

Figure 3.6: Stress-strain curves of HPDC tensile sample #7 and 325ºC 4h heat treated AM tensile sample #1, up to 

1% strain (left) and up to 45% strain (right). 

Afterwards, tensile bars that had been cut out in a vertical orientation were tested to measure the 

maximum yield strength difference from a difference in orientation. Before heat treatment, the 

difference between samples printed horizontally and vertically was about 7 MPa, while after heat 

treatment, the difference was about 4 MPa, leading to an average yield stress for the vertical bars of 

123.5 MPa. This gives a 6.4% deviation from the aimed HPDC yield stress which is also within the 

desired limits of 10% error, meaning that all the material within any AM part will be somewhere 

within these yield stress limits.  

After testing to determine the optimal heat treatment to match yield stress, the bracket prototype was 

heat treated along with a set of tensile bars to determine the effectiveness of the heat treatment 

procedure on an actual prototype. The tensile bars were tested in both orientations to compare to the 

original tensile samples. The results are shown in Figure 3.7 compared to the results from the original 

heat treatment testing. 

 

Figure 3.7: Yield Strength comparison between the bars used for developing the heat treatment procedure and the 

bars used for testing the heat treatment procedure that were printed and heat treated along with the test protype 

parts. 
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As shown in Figure 3.7, the yield stress of both sets of tensile bars is almost identical. Given that both 

sets of bars were printed with different printers, heat treated with different furnaces, and tested with 

different tensile machines yet still produced almost identical results both shows that there was no 

significant influence in the results from the testing equipment and that the heat treatment program 

should work for any furnace that is calibrated correctly. 

3.2.1 Correlation between the yield strength and hardness  

To complete the 4-hour heat treated tensile bar series and to get a better understanding of the exact 

relationship between hardness and yield strength, single tensile bars were heat treated along with 

hardness samples to create a similar plot to Figure 3.1. This plot is shown in Figure 3.8. The 350-

500ºC samples were only done with one tensile bar each due to a lack of samples, so it is not known 

what the true value or uncertainty is for these samples. However, based on the standard deviation of 

the temperatures that had multiple samples taken, the variation should be low enough to illustrate the 

general trend. 

 

Figure 3.8: Yield stress (left axis) and Hardness (right axis) vs 4-hour treatment temperature. 

As stated earlier, hardness can be used to predict yield stress relatively accurately. Using the 

experimental data of tensile bars and hardness samples that were heat treated at the same time, a slope 

was fit to the relationship between yield strength and hardness, seen in Figure 3.9.  

 

Figure 3.9: Relationship between yield strength and hardness from measured data. 

The equation fit to this slope was: 

2.58𝑥 − 56.84 (3. 3) 

Comparing this to Equation 3.1, the results are very close, with the slope only differing by 1.6% and 

the y-intercept differing by 13.6%. This shows that the yield stress-hardness relationship holds up, 
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that the results in this report are in agreement with reported data, and provides a direct and more 

certain way to convert the hardness data in this report into yield stress. 

3.3 Microstructure 

Due to the rapid rate of cooling associated with PBF-LB/M, as AlSi10Mg solidifies it produces a 

cellular microstructure consisting of cells of supersaturated α-Al surrounded by a matrix of eutectic 

silicon rich in magnesium [19]. An example of this microstructure is shown in Figure 3.10. The cells 

tend to get larger near the edges of the laser melt pool due to differences in cooling rates (see Figure 

3.10). Above around 290ºC, this microstructure starts to break down and spheroidizes into blobs of 

eutectic silicon [3]. This initial change in microstructure causes a large decrease in strength due to 

the Hall-Petch effect, since the Si-rich walls of the cellular microstructure act as obstacles blocking 

dislocation movement. This means that when the Si-rich cell walls start breaking apart, they can no 

longer act as obstacles for dislocation movement, and any strengthening from the Hall-Petch effect 

will only come from the much larger actual grains [20]. At the same time as the cells start to break 

apart, the α-Al starts to precipitate the supersaturated silicon, which grows on the surrounding cell 

walls, reducing the effect of solid solution strengthening [21], [22]. As both temperature and time 

increase, the size of the precipitates increases, decreasing the overall strength of the material through 

the mechanism of precipitation hardening [22]. The precipitates get larger due to coalescence and 

Ostwald ripening, as the higher temperatures allow for faster migration of small Si particles to large 

ones, reducing the surface energy of the system by reducing the total precipitate surface area [22], 

[23]. Increasing temperature has little to no effect on the grain size [19], [24], [25], meaning that 

weakening from the Hall-Petch effect has a negligible impact on the strength after the cellular 

microstructure dissolves. 

 

Figure 3.10: Cellular microstructure of as-printed AlSi10Mg as seen with a LOM (left) and SEM (right). 

3.3.1 Precipitate size 

At around 300ºC the as-printed cellular microstructure starts to dissolve, and the first precipitates 

begin to develop. These fine precipitates increase in size as temperature and treatment time increases. 

In Figure 3.13 it can be seen how the precipitates increase in size with time at 500ºC, while Figure 

3.11 and Figure 3.12 show how the precipitates increase in size with temperature at 1 hour of 

treatment holding time. The size of these structures is near the resolution limit of light optical 

microscopy, so while the large precipitates produced at higher temperatures can be resolved, scanning 

electron microscopy is needed for detailed analysis. 
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Figure 3.11: Microstructure of heat-treated PBF-LB processed AlSi10Mg treated at 300ºC (a), 350ºC (b), 400ºC (c), 

450ºC (d), and 500ºC (e) for 1 hour as seen with an LOM. 

 

 

Figure 3.12: Microstructure of heat-treated PBF-LB processed AlSi10Mg treated at 300ºC (a), 350ºC (b), 400ºC (c), 

450ºC (d), and 500ºC (e) for 1 hour as seen with an SEM. 

(a) (b) (c) 

(d) (e) 

(a) (b) (c) 

(e) (d) 
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Figure 3.13: Spheroidization progression at 500°C with samples at 30 min (a), 1 h (b), 2 h (c), and 4 h (d). 

 

Based on an image analysis using SEM images at 20000x magnification on the etched samples 

(Figure 3.12 and Figure 3.13), it can be shown analytically that the average precipitate radius 

increases with temperature and time. Figure 3.14 (a) shows the relationship between temperature and 

precipitate radius, with each increase in temperature resulting in a radius increase. The error increases 

at higher temperatures due to the particles coarsening, meaning that fewer particles were analyzed to 

get the average. Figure 3.14 (b) shows the relationship between treatment time and precipitate radius, 

with each increase in time resulting in a radius increase, although the effect decreases with increasing 

time.  

 

  

Figure 3.14: Average Si-rich precipitate radius from 300ºC to 500ºC for 1 hour (a) and from 30 minutes to 4 hours at 

500ºC (b). 

As has been reported by [22] and [23], the development of precipitates in printed and heat treated 

AlSi10Mg can likely be described by Ostwald ripening. This is a process where smaller particles tend 

(a) (b) 

(a) (b) 

(c) (d) 
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to combine and grow larger over time to decrease surface energy. The general equation for this 

process when describing the development of precipitates in metals is [26]: 

𝑟 = 𝐴 ∙ 𝑡
1
3 (3. 4) 

Where 𝑟 is the average radius of the precipitates, 𝐴 is a constant that is temperature dependent, and 𝑡 

is the time. 𝐴 can be described by the following relation: 

𝐴 ∝
𝐷 ∗ 𝛾

𝑇
(3. 5) 

Where 𝐷 is the diffusion coefficient between the two materials, 𝛾 is the interface energy between the 

two materials, and 𝑇 is the temperature. The diffusion coefficient is temperature dependent and for 

solids can be described by the Arrhenius Equation [27]. For Aluminum and Silicon, this equation and 

the associated variables has been described by [28] in the context of silicon spheroidization in 

aluminum-silicon alloys with the following formula: 

𝐷s = 𝐷0 ∙ exp (−
𝐸A,inter − 𝐸A,v

𝑅 ∗ 𝑇
) (3. 6) 

 

Where 𝐷s is the diffusion coefficient, 𝐷0 is the frequency factor, 𝐸A,inter is the activation energy for 

Al-Si interdiffusion, 𝐸A,v is the activation energy for vacancy formation in aluminum, and 𝑅 is the 

universal gas constant. The values for aluminum and silicon are listed in Table 3.3. 

 

Table 3.3: Values of constants in Equation (3.6). Values from [28]. 

Universal Gas Constant 𝑅 8.314 [J/K] 

Interfacial Energy of Al-Si Interface 𝛾 ~1 [J/m2] 

Frequency Factor 𝐷0 2.29 × 10−4 [m2/s] 

Activation Energy for Al-Si interdiffusion 𝐸A,inter 148.6 [kJ/mol] 

Activation energy for vacancy formation in Al 𝐸A,v 74.3 [kJ/mol] 

 

Using the values in Table 3.3 it is possible to calibrate the model for Ostwald ripening in the range 

of temperatures studied, but since 𝐴 is only proportional to 𝑇, this means that the final values from 

the model must be scaled to fit the measured data using a simple linear regression. Doing this for the 

measured average radius of the samples shown in Figure 3.14 gives the theoretical fit lines in Figure 

3.14. The fit line is very accurate for the temperature change curve (Figure 3.14 (a)) and relatively 

accurate for the time change curve (Figure 3.14 (b)). Both sets of data are also plotted on Figure 3.15, 

which shows a theoretical surface of precipitates size based on the model for Ostwald Ripening. 
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Figure 3.15: 3D plot of theoretical precipitate radius vs temperature and time based on a model of Ostwald ripening. 

This model is able to relatively accurately predict the precipitate radius once the precipitates have 

coalesced into distinct particles, but before that, there is still a transitional period where the as-printed 

cellular microstructure has started to break down, but distinct precipitate particles have not started to 

develop. This can be seen in Figure 3.16, where the temperature of 300°C is low enough that the 

remnants of the cellular microstructure are still visible at 30 minutes and 1 hour (Figure 3.16 (a) and 

(b)). This means there isn’t a clear way to choose how the particles should be segmented, and the 

results cannot be used to compare holding time and particle radius. 

 

Figure 3.16: Spheroidization progression at 300°C with samples at 30 min (a), 1 h (b), 2 h (c), and 4 h (d). 

At the same time that the average precipitate radius is increasing, the volume fraction of the Si-rich 

precipitates is decreasing, although at 250ºC and 300ºC the volume fraction increases above the 

baseline of the as-printed material (see Figure 3.17). These trends can likely be explained by two 

(a) (b) 

(c) (d) 
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effects. The first comes from the fact that the rapid heating and cooling in the PBF-LB process causes 

more silicon to be dissolved in the aluminum matrix than would otherwise be possible [21]. Once the 

heat treatment temperature increases, these supersaturated silicon atoms become more mobile and 

diffuse to the Si-rich precipitates, making them larger and increasing their overall area fraction. This 

can be seen at the 250ºC and 300ºC data point in Figure 3.17 (a) and all of Figure 3.17 (b). 

 

 
Figure 3.17: Area fraction of Si-rich precipitates with increasing treatment temperature at 1 hour (a) and with 

increasing holding time at 300ºC (b). 

However, while the precipitates are rich in silicon relative to the surrounding matrix, they still start 

out primarily composed of aluminum [29], [30]. The solubility of aluminum in silicon is extremely 

small, with the maximum solubility of 0.016 ± 0.003 at.% occurring at 1190ºC, and decreasing with 

temperature [31]. This means that at higher treatment temperatures and longer holding times, the 

aluminum should diffuse out of the silicon, making the overall area fraction of the Si-rich precipitates 

smaller. This effect was observed by [32], who measured the composition of the eutectic silicon in 

AlSi10Mg manufactured by PBF-LB before and after heat treatment at 500ºC. Their results are shown 

in Figure 3.18 and show that even after only 15 minutes of heat treatment at 500ºC, the vast majority 

of the aluminum in the eutectic silicon has diffused out, going from 84% to 17% of the composition. 

 

Figure 3.18: At.% aluminum in eutectic silicon before and after heat treatment at 500ºC. From data in [32]. 

3.3.2 Precipitation strengthening 

As stated before, after the first strength drop from the breakup of the cellular Si microstructure, any 

subsequent loss in strength is primarily a result of the loss of precipitation hardening as particles get 

larger. As the Si particles are relatively large (on the order of 100 nm – 1 µm), this puts the material 

in the bowing regime, as the critical radius between dislocation shearing and dislocation bowing is 

generally around 10-100 nm [33]. In the dislocation bowing regime, the strength from precipitation 

strengthening is proportional to 
1

𝑟
, with 𝑟 being the average particle radius [33]. 

(a) (b) 
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Using the precipitate size model from Ostwald ripening, this allows a prediction for the general trends 

of material strength with respect to heat treatment time and temperature. The results of this model are 

shown in Figure 3.19: 

 

Figure 3.19: 3D plot of theoretical strengthening from precipitation hardening, based on the Ostwald ripening model 

for precipitate radius shown in Figure 3.15. 

However, the 
1

𝑟
 relation is only valid when the volume fraction of precipitate is fixed, which in this 

case is complicated by the fact that the volume fraction of precipitates decreases with time and 

temperature, as seen in Figure 3.17. To compensate for this, the relationship must be adjusted to 

account for a changing volume fraction. 

The governing equation of precipitation strengthening in the bowing regime is given by Orowan 

looping [33]: 

𝜏 =
𝐺𝑏

𝐿 − 2𝑟
(3. 7) 

Where 𝜏 is the material strength, 𝐺 is the shear modulus, 𝑏 is the Burgers vector, 𝐿 is the distance 

between the centers of the precipitates, and 𝑟 is the precipitate radius. To calculate 𝐿 for an evenly 

distributed set of particles, the mean inter-particle distance must be calculated. An estimation that can 

be used is the Wigner-Seitz radius [34]: 

𝑟𝑠 = (
3

4𝜋𝑛
)

1
3

(3. 8) 

𝑛 =
𝑁

𝑉
(3. 9) 

Where 𝑟𝑠  is the radius of a sphere containing 𝑁  particles, 𝑛  is the particle density, and 𝑁  is the 

number of objects in a volume 𝑉. For 𝑁 = 1, 𝑉 will be the total volume of a single precipitate and 

the sphere of matrix surrounding it. The distance between the centers of two particles will thus be 

2𝑟𝑠.  

𝐿 = 2𝑟𝑠 (3. 10) 

Assuming the precipitate is a sphere, the volume of the precipitate will be: 

𝑉𝑝 =
4

3
𝜋𝑟3 (3. 11) 

Where 𝑟 is the radius of the precipitate. Dividing the precipitate volume by volume 𝑉 will give the 

volume fraction 𝑉𝑓 of the precipitate in the material: 

𝑉𝑓 =
𝑉𝑝

𝑉
(3. 12) 
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This can be rearranged to solve for 𝑉: 

𝑉 =
𝑉𝑝

𝑉𝑓
(3. 13) 

Substituting Equation (3.9) into Equation (3.8) gives: 

𝑟𝑠 = (
3𝑉

4𝜋𝑁
)

1
3

(3. 14) 

Substituting Equation (3.13) into Equation (3.14) with 𝑁 = 1 gives: 

𝑟𝑠 = (
3𝑉𝑝

4𝜋𝑉𝑓
)

1
3

(3. 15) 

Substituting Equation (3.11) into Equation (3.15) and simplifying gives: 

𝑟𝑠 =
𝑟

𝑉𝑓
1
3

(3. 16) 

Substituting Equation (3.16) into Equation (3.10) gives: 

𝐿 =
2𝑟

𝑉𝑓
1
3

(3. 17) 

Knowing 𝐿 allows the material strength 𝜏 to be defined by substituting Equation (3.17) into Equation 

(3.7) and simplifying: 

𝜏 =
𝐺𝑏 ∙ 𝑉𝑓

1
3

2𝑟 (1 − 𝑉𝑓
1
3)

(3. 18) 

Since 𝐺 and 𝑏 are constant for a given material, this means that 𝜏 is proportional to 
1

𝑟
 and 

𝑉𝑓
1
3

1−𝑉𝑓
1
3

: 

𝜏 ∝
1

𝑟
∙

𝑉𝑓
1
3

1 − 𝑉𝑓
1
3

(3. 19) 

This relationship allows for hardness to be plotted against average precipitate radius and precipitate 

volume fraction by using the result of Equation 3.19 for the x-axis. Looking at all the samples 

analyzed with the SEM where no other strengthening mechanisms played a major role, this 

relationship holds up, as seen in Figure 3.20. 
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Figure 3.20: Relationship between hardness, average precipitate radius, and precipitate volume fraction. The x-axis 

accounts for both the average precipitate radius and the volume fraction of precipitates as shown in Equation 3.19. 

While it has been empirically observed that precipitate volume fraction decreases with time and 

temperature due to aluminum diffusion from the eutectic silicon (see Figure 3.17 and Figure 3.18), 

the exact mechanism and a suitable model to describe the diffusion process and change in precipitate 

volume fraction was not found during the course of this research. However, using a linear fit on 

Figure 3.17 (a) to roughly approximate the change in precipitate volume fraction with temperature 

allows for a comparison to be made that shows how the volume fraction affects strength. A model 

that relates treatment temperature and time with strength from precipitation hardening is shown in 

Figure 3.21 and compares the strength of a constant precipitate volume fraction and a precipitate 

volume fraction that changes with temperature. 

 
Figure 3.21: 3D plot of theoretical strengthening from precipitation hardening, assuming a value of 26 GPa for the 

shear modulus and 0.2864 nm for the Burgers vector [35]. The lower surface has a fixed precipitate volume fraction of 

10%, while the upper surface has a variable precipitate volume fraction based on the trends in Figure 3.17 (a). 

3.3.3 Solid solution strengthening 

The effect of solid solution strengthening is evident during both the early loss of strength at the 

beginning of heat treatment and in the increase of strength when quenching from high treatment 

temperatures. Silicon atoms in the α-aluminum matrix will increase the strength of the material 

through solid solution strengthening. However, the solubility of silicon in aluminum only becomes 
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significant at higher temperatures near the eutectic temperature, with a maximum solubility of 1.5 

at.% at 577ºC [31] and decreasing with decreasing temperatures (see Figure 3.22). This means that 

under normal conditions, there will be little silicon in the α-aluminum matrix. However, the PBF-LB 

process causes aluminum to very rapidly melt and cool, leading to a nonequilibrium state and leaving 

the α-aluminum matrix supersaturated with silicon, with contents up to ~7 wt.% [21]. This, along 

with the dislocation blocking effect of the Si-rich cells, causes the as-built strength of Al-Si alloys 

manufactured through PBF-LB to be so high. 

 
Figure 3.22: Solubility of silicon in an aluminum matrix with respect to temperature. Adapted from [31]. 

This supersaturated silicon starts to diffuse out of the α-Al matrix before spheroidization begins, 

causing an initial loss in strength starting around 200ºC and continuing until around 300ºC [36]. This 

diffusion of silicon is enhanced by vacancies remaining in the material that were caused by the rapid 

cooling of the PBF process [36]. This shows why the samples treated at 250ºC in Figure 3.2 have lost 

some strength relative to the as treated sample but are still stronger much than samples treated at 

300ºC and don’t show the same hardness curve shape. The increased area fraction of silicon rich 

precipitates (as shown in Figure 3.17 (a)) implies that the majority the dissolved silicon has already 

precipitated from the solid solution and grown on the cell walls, meaning that solid solution 

strengthening no longer provides a significant amount of strength. However, Figure 3.23 shows that 

the cellular microstructure is mostly unchanged, meaning that the cell walls are still blocking 

dislocation movement, providing strength, and precipitation hardening, (which is responsible for the 

hardness curve shape starting at 300ºC), has not started to provide strength yet. 

 

Figure 3.23: Microstructure of PBF-LB produced AlSi10Mg after heat treatment at 250ºC for 1 hour. 
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The second way solid solution strengthening can affect the strength of the material is through 

controlling the cooling rate after heat treatment. As shown in Figure 3.22, the solubility of Si an Al 

starts to increase above 300ºC, and this dissolved Si can be locked in the α-Al matrix if the material 

is cooled rapidly enough to prevent the Si atoms from migrating to the Si-rich precipitates during 

cooling. Since this requires the Si to already be dissolved in the α-Al matrix, quenching to increase 

strength is only effective after heat treating at high temperatures, where Si is more soluble. This effect 

can be seen in Figure 3.24, which shows that after cooling from 325ºC the cooling method had 

practically no effect on hardness, while after cooling from 550ºC, the water quenched sample had 

almost double the hardness of the furnace cooled sample. This shows that at lower solutionizing 

temperatures, the cooling rate does not significantly affect the strength of the material, while at higher 

solutionizing temperatures, it is important to take the cooling rate into account when developing a 

heat treatment procedure. 

 
Figure 3.24: Hardness of heat-treated samples water quenched, air cooled, and furnace cooled after heat treating at 

325ºC or 550ºC for 4 hours. 

This effect is likely why starting at 450ºC, the hardness values in Figure 3.2 and Figure 3.3 start to 

decrease slower, and actually increase at 550ºC relative to 500ºC. These samples were air-cooled and 

as Figure 3.24 shows, even air-cooled samples experience a significant amount of solid solution 

strengthening from dissolved silicon remaining in the matrix.  

An equation used to estimate the effect solid solution strengthening is as follows [33]: 

∆𝜎𝑠 = 𝑘𝑠√𝑐 (3. 20) 

 

Where ∆𝜎𝑠 is the change in shear yield strength from solid solution strengthening, 𝑘𝑠 is the solid 

solution strengthening coefficient between the two materials, and 𝑐 is the atomic concentration of 

solute atoms. 

Using a best fit on the silicon solubility curve shown in Figure 3.22 and Equation 3.19, it is possible 

to predict the relative effect of solid solution strengthening at different temperatures, assuming that 

all the dissolved silicon in the aluminum matrix remains there after quenching. This prediction is 

shown in Figure 3.25. 
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Figure 3.25: Maximum possible strengthening effect of solid solution strengthening based on quenching. 

3.4 Surface roughness 

As printed, the surface roughness is primarily determined by the size of the particles used, the layer 

thickness, and process parameters applied, however there are post-processes that can be used to 

improve surface roughness. These include physical methods like sand/glass blasting and 

electrochemical processes like Hirtisation®. Given that not all surfaces on HPDC parts are machined 

and some are used as-cast, getting closer to the roughness of as-cast parts is desirable, as the surface 

roughness can determine the friction between bolts and other components mounted to the part. 

The surface roughness was measured in three places on the HPDC part to see what kind of surface 

finish is created by HPDC and how it varies across a part. The results are shown in Table 3.4. 

Table 3.4: Surface roughness values at the three measured HPDC sections 

Parameter Position 1 Position 2 Position 3 

Ra 0.93 ±0.1 µm 0.89 ± 0.16 µm 0.36 ± 0.04 µm 

Rz 7.23 ±1.07 µm 8.55 ± 1.4 µm 3.87 ± 0.45 µm 

Rt 9.35 ± 2.21 µm 10.59 ±1.86 µm 4.47 ± 0.73 µm 

Sa 1.24 µm 2.16 µm 0.44 µm 

S10z 27.64 µm 66.22 µm 23.62 µm 

Sdr 3.65 µm 6.03 µm 3.08 µm 
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Figure 3.26: Surface topography of the three measured positions on the HPDC part.  

All three values of arithmetical mean height (Ra) are quite low, below 1 micron, although there is 

significant deviation between the positions. Looking at Figure 3.26, in positions 1 and 3 it appears 

that the majority of the surface roughness comes from surface striations that likely came from the 

texture of the mold the part was cast in, while in position 2, the striations are less present and much 

of the texture appears to come from porosity and casting defects. However, all of these surface 

roughness values are still on the same order of magnitude, meaning that any defects from the casting 

process will still be close to the surface roughness tolerance of positions that are defect-free. 

 

Figure 3.27: Surface roughness values of the two 3D printed AlSi10Mg cubes before and after surface treatments. Cube 

1 was treated with Hirtisation®, Cube 2 was treated with glass blasting. 

 

(a) (b) 

(c) 
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Figure 3.28: Surface topography of two untreated printed AlSi10Mg cubes. Sides 3 (a),(c) and 5 (b),(d)  for cube 1 

(a),(b) and cube 2 (c),(d). 

 

 

Figure 3.29: Surface topography of two printed AlSi10Mg cubes. Sides 3 (a),(c) and 5 (b),(d) for cube 1 (a),(b) and 

cube 2 (c),(d). Cube 1 was treated with Hirtisation® and cube 2 was treated with glass blasting. 

(a) (b) 

(c) (d) 

(a) (b) 

(c) (d) 
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Both cubes start with an Ra surface roughness of around 4 µm which is higher than all the values for 

the HPDC surfaces, however it is still in the same range. Most of the roughness from the printed parts 

appears to come from small metal powder particles that are stuck to the surface of the cubes, apart 

from side 1, where the top of the cube is not as flat as the sides and does not have powder stuck to it.  

Both Hirtisation® and glass blasting were able to remove the metal powder particles but produced 

different effects on a local scale. On a local scale, Hirtisation® was able to create a smoother surface 

than glass blasting, however, it also opened subsurface pores that increased the overall surface 

roughness compared to glass blasting. Given that Hirtisation® removes the top surface of 3D printed 

parts, namely the contour scan, it is possible that it revealed subsurface pores concentrated between 

the contour and hatch scans (as seen in Figure 3.30). For this reason, glass blasting was chosen over 

Hirtisation®. 

 

 

Figure 3.30: Un heat treated AlSi10Mg sample showing large pores left in the outline around the sample. 

According to the datasheet from SLM Solutions, the as-built surface roughness of AlSi10Mg using 

an SLM280 is 8 ± 2 µm with a 30 µm layer height and 16 ± 4 µm with a 60 µm layer height [37]. 

This is much higher than the as-cast roughness of the HPDC parts, so surface treatment or machining 

is required to match the roughness of any interface surfaces that need specific friction properties. 

3.5 Dimensional changes 

Each step of the post-process from 3D printing to producing a finished prototype part has the potential 

to introduce unwanted dimensional changes, so the prototype part was scanned between each step to 

observe any differences.  

Before and after the heat treatment, the powertrain suspension bracket was scanned on its build plate, 

and the results are shown in Figure 3.31. The biggest measured deviation is around 0.35 mm, near 

the top of the bracket, with most of the part having very small deviations before and after. The 

resolution of the scanner is 0.050 mm and the accuracy is 0.030 mm [38], so it is possible that some 

of these small deviations could come from error between scanning operations. However, the larger 

deviations do show a change caused by the heat treatment process.  
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Figure 3.31: Dimensional differences of AM powertrain suspension brackets after heat treatment. 

After the bracket was cut from the build plate, machined, and surface treated, it was scanned again to 

obtain a final measure of the overall accuracy through the entire prototyping process. The comparison 

between the final prototype bracket and the original CAD model that it is based on is shown in Figure 

3.32. Overall, the vast majority of the surfaces on the bracket are within ± 0.1 mm of the original 

CAD model, showing that even after all the post-processing steps the print came out accurate. The 

one major exception to this is one side of the center bushing hole, which varies by over 0.35 mm, up 

to around 0.5 mm. However, this surface is the one section that was not printed but was rather 

machined out of a block of support after printing (as seen in Figure 2.16). This means that the error 

there likely came from the post-processing milling step, and not any inherent error with printing and 

warping that occurred as a result. Given that this section was difficult to machine and the support 

structure would likely be changed for any future prints, this issue may not appear again and just shows 

where more considerations may need to be taken in the future. 
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Figure 3.32: Differences between the final 3D printed part and the original CAD model. 

In order to obtain a reference for what is an acceptable level of deviation from the original CAD 

model, a production part made with HPDC was scanned and compared to the original model. The 

results of this analysis are shown in Figure 3.33. The results show that while a decent portion of the 

part is within ± 0.1 mm deviation, there are many sections with greater error, including large portions 

with over 0.35 mm deviation. Most of these deviations are in sections without mounting surfaces, so 

part functionality should not be majorly affected, but it shows that elsewhere more major deviations 

are acceptable for production. Comparing the deviations to the printed part in Figure 3.32, the printed 

part is actually more accurate, with the exception of the machining error in the center bushing hole. 

Overall, this shows that the printing process is more than acceptable for producing a dimensionally 

accurate functional prototype. 
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Figure 3.33: Differences between a production HPDC part and the original CAD model. 

3.6 Porosity 

Larger porosities were measured on a component level by CT scanning, while smaller porosities were 

measured in test samples with a higher resolution by using an optical microscope. CT scanning was 

also able to show the location of porosities in the parts. 

3.6.1 Porosity from light optical microscopy 

The results of porosity analysis by LOM show that heat treating a part produced by PBF-LB increases 

the porosity of the material, with greater holding time generally causing the porosity to increase 

further (see Figure 3.34). However, differences in heat treatment temperature do not appear to 

significantly change the porosity. The increase in porosity appears to primarily be from the existing 

pores growing larger, as can be visually seen in Figure 3.35. 
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 Figure 3.34: Porosity after heat treatment with respect to treatment temperature and holding time. 

 

 
Figure 3.35: Pores of printed AlSi10Mg untreated (left) and heat treated at 350°C for 2 hours (right). 

3.6.2 Porosity from CT scanning 

The results of porosity analysis using CT scanning show that the printed prototype parts contain very 

few large porosities (see Figure 3.36), such that the measured porosity was less than 0.002%. 

However, the HPDC part was shown to have far more and larger pores which were inhomogeneously 

concentrated in thicker sections of the casting (see Figure 3.37).  
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Figure 3.36: Internal Porosity of the printed prototype bracket (purple area in the background comes from a scanning 

error). 

 

Figure 3.37: Internal porosity of the HPDC motor mount bracket. 

Knowing the porosity of the HPDC part is useful for future research on modifying the porosity of 

parts produced by AM to match the ductility of HPDC parts, since this gives a baseline porosity defect 

size to aim for when attempting to modify ductility that shouldn’t introduce issues with fatigue.  

The differences between the measured porosities from light microscopy primarily are due to 

differences in resolution. For the light microscopy images, the resolution of 1 pixel was ~1.1 μm, 

while for CT scanning, the resolution of one pixel/voxel was 62.2 μm in each dimension, so any 
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features smaller than that would be lost. This difference in resolution means that smaller pores were 

unable to be measured with CT scanning. As the porosity in the printed part is relatively isotropic, 

performing light microscopy on small sections of the printed material is superior to using CT 

scanning. However, since the porosity in the HPDC part is anisotropic and has comparatively more 

and larger pores, performing light microscopy on a small section will not be able to measure a 

representative sample of pores throughout the part, meaning that using CT scanning to measure the 

whole part is the only way to get an accurate overall porosity. CT scanning can still be used to measure 

the relative porosity between HPDC and AM parts printed with different settings for future studies 

modifying the bulk porosity. 

In an attempt to overcome some of the limitations of automated pore analysis with the Comet Yxlon 

Void Insights tool, individual slices were exported every 1 mm and also analyzed with ImageJ using 

Trainable Weka Segmentation to separate the pores from the metal from the background. This method 

found the porosity for the whole bracket to be 0.46%, which is likely closer to the true value, even if 

the CT scan is still unable to see smaller pores. 
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4 Conclusions 

4.1 Research goals 

The primary goal of this research was to determine if it is possible to use additive manufacturing to 

create functional prototypes of parts manufactured using high pressure die casting. The properties 

investigated were yield strength and surface roughness, with ductility being measured but not 

optimized for. The results showed that it is possible to heat treat parts printed using normal printing 

parameters and obtain values for yield stress very close to that of HPDC AlSi12(Fe). Heat treating 

printed AlSi10Mg at 325ºC for 4 hours was able to lower the yield stress to 127.0 ± 0.8 MPa, which 

is only 3.8% lower than the yield stress of HPDC AlSi12(Fe), within the desired limit of 10%. In 

addition, the geometry of the prototype part was able to be printed with minimal errors due to residual 

stresses and processing. 

In addition to determining if it is possible to use metal additive manufacturing for HPDC prototypes, 

the different strengthening mechanisms of heat-treated aluminum manufactured using PBF-LB were 

also determined and characterized. The primary strengthening mechanisms for as-printed AlSi10Mg 

are Hall-Petch strengthening from the cellular microstructure produced by printing and solid solution 

strengthening produced by rapid cooling. The primary strengthening mechanisms for printed and heat 

treated AlSi10Mg are precipitation hardening, which is dependent on heat treatment time and 

temperature, and solid solution strengthening, which is dependent on heat treatment temperature and 

cooling rate. With these strengthening methods characterized, it is possible to customize the strength 

of an AM produced part depending on the requirements. 

4.2 Future work 

While this thesis managed to prove that AM parts can be customized to provide matching strength 

for HPDC prototypes, there is still much more research to be done in the future. The first that could 

be done is functional testing of the prototype manufactured during the research. This would involve 

mounting the prototype part to the test rig normally used for testing sand cast prototypes and testing 

how it performs compared to sand cast and HPDC parts. Another future avenue of research would be 

investigating how to modify the ductility of printed parts. Due to differences in the alloys used for 

HPDC and printing, printed parts tend to have much higher ductility than HPDC parts. This can 

theoretically be modified during the printing stage by intentionally printing with suboptimal 

conditions to introduce porosities into the material, thereby reducing ductility. While this property is 

not as important as yield strength, it is still useful for crash testing and if implemented properly can 

also be used for showing that a prototype has failed, as this is not as obvious with only yielding. As 

there are also other aluminum alloys used in HPDC at Volvo Cars, another avenue of research could 

be to test different printing alloys and try to match different casting alloys. This could build on the 

research done in this report using the same testing framework. Finally, to make the process more cost 

and time effective, more research could be done on printing and post-processing optimization. If 

porosity can be increased without decreasing yield strength, then it would be possible to increase the 

print speed thus decreasing cost and turnaround time. In addition, supports could also be optimized 

to minimize print time and make post-processing easier, as with the current prototypes there was 

some difficulty with removing the supports.  
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